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Radio and television interference

The equipment described in this manual generates, uses, and can radiate radio-
frequency energy. If it is not installed and used properly—that is, in strict accordance
with Apple’s instructions—it may cause interference with radio and television reception.
This equipment has been tested and found to comply with the limits for a Class B digital
device in accordance with the specifications in Part 15 of FCC rules, These specifications
are designed to provide reasonable protection against such interference in a residential
installation. However, there is no guarantee that the interference will not oceur in a
particular installation.

You can determine whether your computer system is causing interference by turning it
off. If the interference stops, it was probably caused by the computer or one of the
peripheral devices.

IFyour computer system does cause interference to radio or television reception, try to
correct the interference by using one or more of the following measures:

m Turn the television or radio antenna until the interference stops.

m  Move the computer to one side or the other of the television or radio,

m Move the computer farther away from the television or radio.
[

Plug the computer into an outlet that is on a different circuit from the television or
radio. (That is, make certain the computer and the television or radio are on circuits
controlled by different circuit breakers or fuses.)

If necessary, consult your authorized Apple dealer or an experienced radio/television
technician for additional suggestions. You may find helpful the following booklet,
prepared by the Federal Communications Commission: Interference Handbook (stock
number 004-000-00345-4), This booklet is available from the U.S. Government Printing
Office, Washington, DC 20402.

43 Important: Changes or modifications to this product not authorized by Apple
Computer, Inc,, could void the FCC Certification and negate your authority to
operate the product.

This product was tested for FCC compliance under conditions that included the use
of shielded cables and connectors between system components. It is important that
you use shielded cables and connectors to reduce the possibility of causing
interference to radios, television sets, and other electronic devices, For Apple
peripheral devices, you can obtain the proper shielded cables from your authorized
Apple dealer. For non-Apple peripheral devices, contact the manufacturer or dealer
for assistance. A

Important

This equipment has been tested and found to comply with the limits for a Class B
digital device in accordance with the specifications in Part 15 of FCC rules. See
instructions if interference to radio or television reception is suspected.

DOC Class B Compliance This digital apparatus does not exceed the Class B limits
for radio noise emissions from digital apparatus set out in the radio interference
regulations of the Canadian Department of Communications.

Observation des normes—Classe B Le présent appareil numérique n'émet pas de
bruits radioélectriques dépassant les limites applicables aux appareils numériques de la
Classe B prescrites dans les réglements sur le brouillage radioélectrique édictés parle
Ministere des Communications du Canada,
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Chapter 1

Getting Started

The StyleWriter II provides a fast, economical way for you to
produce high-quality printed text and gray-scale graphics. You can
load it with up to 100 sheets of paper or 15 envelopes at a time.
And if your Macintosh is connected to a network, you can share
your printer with other users.

The StyleWriter Il works with Macintosh computers that use
system software version 7 or later. You can also use version 6.0.7
or later. You must have a hard disk drive to use the StyleWriter I1.
If you're new to the Macintosh, read the books that came with
your computer before proceeding. You'll need to know basic
operations and vocabulary before you set up and print with the
StyleWriter I1.

Your StyleWriter I works with all fixed-size and TrueType fonts.
TrueType allows you to display and print fonts smoothly in
virtually any size. A number of TrueType font families (typefaces)
are included on the disks that came with your printer. These fonts
are automatically installed on your Macintosh when you follow the
directions in this chapter. For more information about using fonts,
see the books that came with your Macintosh or with your latest
system software update.



Impor[am Sa_fe[y instructions = Don't drink or swallow the ink. It's not toxic, but it's not for

human consumption. Keep ink cartridges away from children.
Read all the instructions in this chapter carefully before you plug

the StvleWriter II into an electrical outlet. = Avoid getting ink on your clothes. The ink will eventually wash
' off your hands, but stains on fabrics or clothing are

For your own safety and the safety of your equipment, always take permanent.

the following precautions:

. ‘ = Keep these instructions handy for reference.
s Follow all instructions and warnings dealing with your system.

s Keep the StyleWriter I away from sources of liquids, such as A Warning: Electrical equipment may be hazardous if misused.
wash basins, bathtubs, and shower stalls. Operation of the StyleWriter Il or of similar products must

always be supervised by an adult. Do not allow children access
to the interior of any electrical product and do not permit
them to handle any cables. A

»  Protect the StyléWriter Il from dampness or wet weather, such
as rain and snow.

= Don't use devices that produce open flames, such as Bunsen
burners or welding torches, near the StyleWriter 11,

= Don't use ammonia-based or alcohol-based cleaners, which
can react chemically with the plastic, on or around the
StyleWriter 11.

2 Chapter 1: Getting Started



Watch for these situations and if one occurs
pull the plug!

If you encounter any of these circumstances, disconnect the
power plug immediately! (Pull the plug, not the cord.)

» the power cord or plug is frayed or otherwise damaged
= you spill anything into the case

» the StyleWriter IT is exposed to rain or any other excess
moisture

s the StyleWriter II has been dropped, or the case has been
otherwise damaged

» you suspect that the StyleWriter II needs servicing or repair
= you plan to clean the printer

If you suspect your StyleWriter II is damaged, see the information
about service and support that came with it.

Set up your StyleWriter I

You're ready to set up your StyleWriter II. If you haven't already
done so, unpack your printer and make sure you have everything
listed on your packing list.

Choose a location near your Macintosh computer that has a
grounded electrical outlet, and good ventilation, is out of direct
sunlight, and never gets damp, very hot, or very cold. The printer
works best at

» temperatures between 59° and 86° Fahrenheit (15°and 30°
Celsius)

» relative humidity between 20 and 70 percent

See the appendix for more specific information about the physical
requirements of the printer.

Chapter 1: Getting Started 3



Connect the StyleWriter II to your Macintosh

No matter which Macintosh you have,
To connect your StyleWriter II to your Macintosh computer, you these icons identify the printer and

need a peripheral-8 cable. modem ports.

Before you connect the StyléWriter II to your Macintosh, make
sure the computer is turned off. Then use a peripheral-8 cable to
connect the printer to the computer as shown. It doesn't matter
which end of the cable you use first; both ends are the same.

A Important: It's OK to connect the StyleWriter II to either the
printer port or the modem port. &

4 Chapter 1: Getting Started



Install the ink cartridge 2. Open the package containing your ink cartridge.

The ink cartridge contains the ink the printer uses. Each cartridge 3. Get the ink cartridge ready by following the
lasts for several hundred pages, depending on the kind of printing instructions that came with it.

you do. 4. To install the cartridge, follow the instructions inside

1. Open the access door at the front of the printer. the door of the printer.

5. Close the access door.

Grasp the top corners of the
door and pull it toward you.

The door flips down.

Chapter 1: Getting Started 5



Plug in the StyleWriter II
Connect the power cord to the StyleWriter II first, then plug the
other end of the cord into a grounded electrical outlet.

Insert the power cord into the receptacle
at the back of the StyleWriter 11.

Plug the power cord
into a grounded outlet.

6 Chapter 1: Getting Started

A Warning: 7This equipment is meant to be electrically
grounded. Do not defeat the purpose of the grounding plug!
The StyleWriter 11 is equipped with a three-wire grounding
plug—a plug that has a third (grounding) pin. This plug fits
only a grounding-type AC outlet. If you are unable to insert
the plug into an outlet, contact a licensed electrician to
replace the outlet with a properly grounded one. A



Load paper into the sheet feeder

The sheet feeder holds up to 100 sheets of 20-Ib. paper and feeds
the paper automatically into the printer. To load paper into the
sheet feeder, follow these steps:

1. Raise the paper support as shown.

You can also open the output tray if you wish.

Make sure lever is next
to (€1) paper icon.

Pull here if you want to
open the output tray,
Be sure to pull it out all the way.

2. Load a stack of paper into the sheet feeder.

Move the adjustable guide so that it just touches the edge of
the paper. If the stack of paper bows out even slightly, the
guide is too tight.

Be careful not to overload the sheet feeder. The stack of paper
should not be higher than the indicator line on the right side
of the sheet feeder.

Move the adjustable guide
to fit just against the paper.

Slide paper in, making sure it lines
up evenly at this side of the feeder.

Do not stack paper
above this line.

Chapter 1: Getting Started 7



Turn on the StyleWriter II and print the test page

For normal use you turn the printer on by pressing the power
button (marked with the @ icon). When you turn on the printer,
the amber error light (marked with the 8 icon) comes on for a
moment, then blinks off when you release the power button. The
green power light comes on and stays on,

To print a test page, start with the printer turned off. Press and
hold down the power button for several seconds, until the amber
error light goes out or the test page starts to print.

Error light (8%)  Power light

8 Chapter 1: Getting Started

The test page displays the version of the software built into the
StyleWriter I1. The test pattern printed below the picture of the
printer can indicate problems with the ink cartridge.

[ 1 Apple StyleWriter 11

This tells you which version
L of read-only memory (ROM)
you have in your StyleWriter IL

The pattern should look like
_ this. If the print quality is not
] satisfactory, the ink cartridge
is not installed properly or
needs to be cleaned. See
“Cleaning the Ink Cartridge”
in Chapter 3 .

Your StyleWriter II printer is ready to use. Next you need to get
your Macintosh ready by installing the software that lets it
communicate with the StyleWriter II.



Install your printer software Using the Installer

Before you install the printer software, you need to protect the The StyleWriter IT comes with a program called the Installer that

original disks by locking them and making backup copies. Follow installs printer software onto your hard disk. Follow these steps to

these steps: install the software:

1. Lock the disks that came with your StyleWriter II. 1. Insert the StyleWriter Il Installation disk into a floppy
disk drive.

The disk’s icon appears on the desktop.

2. Open the disk by double-clicking its icon.

I

System Disk

Double-click this icon
to open the disk.

=tallation

Style'w'riter 1l In

Locked Unlocked

continues »
2. Make a backup copy of each disk.
You can find instructions for copying disks in the books that -
came with your Macintosh. You'll need a blank 800 kilobyte
(K) floppy disk for each disk you want to copy.

Chapter 1: Getting Started 9



3. Open the Installer by double-clicking its icon.

Double-click this
icon to open
the Installer.

When you open the Installer, it displays information about the
files to be installed. Click OK.

A\ Important: If you see a message that the Installer cannot
install the printer software, you must upgrade your system
software before proceeding. You can purchase a system
software upgrade kit from an Apple dealer, or you can get the
software for a small fee from a local user group. Call Apple at
(800)538-9696 to find a user group near you. A

4. Click the Install button.

The Installer takes a few moments to calculate what needs to
be done and then begins to copy files. The whole process may
take several minutes.

10 Chapter 1: Getting Started

5. When the StyleWriter Il Installation disk is ejected,
follow the instructions you see on the screen.

You'll have to swap disks a few times. Each time, the Installer
ejects one disk and asks you to insert another. Keep following
the instructions on the screen until the installation is
complete.

When the installation is complete and you are ready to start
printing, turn to Chapter 2.



Using your StyleWriter 11

Before you can print documents on your StyleWriter I1, you need
to do three things first (you do not need to do these things every
time you print):

= choose the printer in the Chooser
= define your page setup
= load paper, envelopes, or other material into the printer

To print a document (from an application program or from the
desktop) you only need to do one thing to begin:

= choose Print from the File menu

If your computer is connected to other Macintosh computers over
a network, you can also:

= share your printer with other users on the network

= use a printer someone else has shared on the network

This chapter tells you how to do all of these things.

Getting help

If you need more information about the choices presented on
your screen when you use your StyleWriter I1, click the Help
button when you see it. If you are using System 7, you can choose
Show Balloons from the Help menu.

About Balloon Help... i

If you use System 7, you can
choose Show Balloons from
the Help menu.

When you see this button,
click it for more information.

11



Choosing a printer

Before you use your StyleWriter II for the first time, you must use
the Chooser to let the Macintosh know what printer you want to

use.

1. Choose the Chooser from the Apple (8) menu.

The Chooser window opens. (Your Chooser may not look
exactly like the illustration, but it should contain the same

elements.)

2. Set the Chooser options as shown here:

1 Click the StyleWriter [T icon.

=

Connect to;

@ <Serial Port>

<

Background Printing

@om oot

AppleTalk

© Active On Restart

@ Inactive

2 Click the top icon if you plugged the printer
into the printer port, or the bottom icon if
you plugged it into the modem port.

12 Chapter 2: Using Your Printer

3. Click the close box.

The Chooser closes.

A\ Important: You don't need to use the Chooser every time
you print. If the StyleWriter IT is the only printer you're using,
this should be the only time you need to use the Chooser to
choose the printer. A



Defining your page setup

You do not have to use Page Setup every time you print; the most
frequently used options are preset for you. To change your
printing options in the Finder or in an application program, follow
these steps:

1.

Choose Page Setup from the File menu.

The Page Setup dialog box appears. The dialog box you see
may not look exactly like the one shown here, but all Page
Setup dialog boxes have many features in common.

In the dialog box, make the selections you want.

To make your document print Choose a page Click here
larger or smaller, type or size from this for more
choose a percentage. pop-up menu. information.

StyleWriter |1 Page Setup 10

Page Size:| US letter |

woen > B oy

(_Help )

Orientation: !@

Click one of these icons to choose
normal (portrait) or sideways
(landscape) orientation.

This picture changes to
indicate your choices.

Choose the page size you want from the Page Size pop-up
menu.

Use the Scaling feature to print your document larger or
smaller than normal. Use the pop-up menu to choose a preset
reduction percentage, or type a percentage from 5 to 999 in
the Scaling box. The percentages listed on the pop-up menu
give the best results for printing smaller than 100%.

The Orientation icons allow you to print your document in
normal (portrait) or sideways (landscape) orientation.

. When you've made your choices, click OK.

Your document is now set up to be printed.

Chapter 2: Using Your Printer 13



Loading the sheet feeder

The sheet feeder holds up to 100 sheets of 20-Ib. paper. You can
use plain paper, letterhead, or three-hole punched paper. If you
use thicker paper, fewer sheets will fit in the sheet feeder.

A\ Important: Paper weight should be between 16 and 24 Ib;
20-Ib. cotton bond paper is recommended. &

You can load other materials into the sheet feeder, including
transparencies, labels, heavy (thick) paper (up to 28 Ib.), and up
to 15 business envelopes. Before you load envelopes or thick
paper into the sheet feeder, you must move the adjustment levers
to the envelope settings.

4\ Important: Insert only one kind of material at a time into the
sheet feeder. &

14 Chapter 2: Using Your Printer

To load the sheet feeder, follow these steps:
1. Set up the StyleWriter II as shown.

Move both levers to the paper icon (to load paper) or to the
envelope icon (to load envelopes or thick materials).

Move both levers to this
icon (€]) to load plain,
letterhead, and 3-hole
punched paper.

Pull the paper support to raise it.

Move both levers to this
icon (=) to load envelopes
and thick materials.



2. Load paper or other material into the sheet feeder.

For best results, crease the leading edge of envelopes, as
shown, before you load them into the sheet feeder.

Crease this edge.

Move the adjustable guide so that it just touches the edge of
the stack of paper (or other material). If the stack bows out
even slightly, the guide is too tight.

Move the adjustable guide Insert envelopes top first, with the
to fit just against the paper. side to be printed facing front.
i
i

Insert 3-hole punched
paper face up with the
holes on this side.

Insert letterhead paper

face up with the top of
the page down.

Pull here if you want to open the output tray.
Be sure to pull it out all the way.

Chapter 2: Using Your Printer 15



Printing

You can print documents from within the application programs
you used to create them. You can also print documents from the
Finder desktop. And with a feature called background printing,

you can keep using your Macintosh computer while your
documents are being printed.

Printing from within a program or from the desktop

To print a document from within an application program, or from
the Finder desktop, follow these steps:

1. Select the document you want to print.

Within an application program, open a document or create a
new one.

In the Finder desktop, click to select the icon of the
document you want to print.

2. Choose Print from the File menu,

In most cases a Print dialog box appears, with options for
printing your document. The dialog box may not look exactly
like the one shown here, but it will have the options shown in
this one.

16 Chapter 2: Using Your Printer

Type the number of copies
you want in this box.

Stylellriter] | 10

coies [ Foger @m0 Orrom: [ 1o [ ]
Print Quality: () Best QNNIHII Qllrnft
Paper Source;  Sheetl Feeder | 7 Manual

image:[ Black O White v |
Notification:[_None ]

Choose Draft for speed,
Best for higher quality.

i€

Click here for
more information.

You can choose:
= the number of copies to print.
= the range of pages to print

» Draft quality for faster printing with lower quality, Normal
quality to balance speed and appearance, or Best quality
for finest quality at slower speed

a  Black & White or Grayscale, to match the type of images
in your document (use Black & White for text)

s the notification you want when your document is printed
(you can choose to be notified by an Alert message that
appears on your screen or by a sound)

3. When the settings are the way you want them, click
Print.



Printing while you use your computer

If you are using System 7 (or MultiFinder in System 6), you can
print with the StyleWriter IT while continuing to work with one or
more programs. This is called background printing. If you use
System 7, background printing is automatically turned on when
you install your StyleWriter Il software.

A Important: If your Macintosh computer has only 1 megabyte
(MB) of random-access memory (RAM), you won't be able to
use background printing. If your computer has 2 MB of RAM
and you have trouble using background printing, turn off the
Share this Printer and Background Printing options, or quit
one or more of your open application programs. 2

To use background printing, you must turn it on in the Chooser.
1. Choose Chooser from the Apple (#) menu.
2. Click the StyleWriter II icon.

3. Click the On button under Background Printing.

FiE—————== hooser

[7] | Connect to:

Fi =

<Serial Port>

g

Background Printing
Son® orr

|| O Act]ve On Restart
[5] | APpieTelk @ inadtive

Click here to turn on
Background Printing

4. Click the close box.

Once background printing is turned on, it is in effect whenever
you print, until you turn it off.

After you click Print in the Print dialog box, a message appears on
the screen for a few seconds, then disappears. You can then
continue other work. You may notice your Macintosh pause
occasionally while it processes the document for printing,

Chapter 2: Using Your Printer 17



Sharing your printer with other users
on a network

If your Macintosh is connected to other computers over an
AppleTalk network, you can allow other users on the network to
print on your StyleWriter II printer.

To share your StyleWriter I with other users, follow these steps:
1. Choose the Chooser from the Apple (%) menu.

The Chooser window opens.
2. Click the StyleWriter II icon.

3. Click the icon of the port to which you connected the
StyleWriter II.

If you used the Printer port to connect your Macintosh to
the network, you must connect the StyleWriter II to the
modem port.

18 Chapter 2: Using Your Printer

4. Click Setup.
The Sharing Setup dialog box opens.

Click to place an X in this
box to share your printer.

L Type a name
for your
printer here.

[JKeep Log of Printer Usage
(e ) Coonder ) (Cox_)

To make your printer available
only to people you choose,
type a password here.

lTn keep a record of what
is printed, click here.

5. Click to place an X in the Share this Printer box.

If you wish, you can type a name for the printer and a
password. If you type a password for the printer, only users
who know the password can use the printer from their
computers.



If you want to keep a record of what is printed on your
printer, click to place an X in the Keep Log of Printer
Usage box.

To see what has been printed, you can open and print the log
file with the TeachText program, or with a word-processing
program. You can find the log file in the Printing Prefs folder.
The Printing Prefs folder is in the Preferences folder inside
your System Folder.

Note: You can keep a log of your printer usage even if your
printer is not shared. <

Click OK.
Click the close box to close the Chooser window.

Other users with Macintoshes connected to the network can
now use your StyleWriter II printer (if StyleWriter II printer
software has been installed on their Macintosh computers as
described in Chapter 1).

Note: When other users print on a printer connected to your
Macintosh while you are using your computer, you may notice
your computer pause occasionally. «

Printing on a shared printer on a network

If your Macintosh is connected over an AppleTalk network to
another Macintosh, and that computer has a connected
StyleWriter II printer set up to be shared, you can print on that
printer. (You must first install StyleWriter 11 software on your
Macintosh, as described in Chapter 1.)

To print on a shared printer, follow these steps:
1. Choose the Chooser from the Apple (%) menu.
The Chooser window opens.

2. Click the StyleWriter II icon.

continues w
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3. If necessary, click an AppleTalk zone.
If your network does not have zones, the list of AppleTalk

Zones does not appear.

Click to select the
StyleWriter II icon.

The available shared

Connect to;
‘@ S ¢Serial Ports|
AppleShire % <Serial Porty

i Kristan's StyleWriter ||
5| | 1% ross’ Shared Printer

I} Eric’s printer

il Mario’s public printer
T Phil's StyleWriter ||

East Zone
Pam's Design Zone

Background Pri nting
Get Info @ 0n O O1f
#DNB+"= ® Active

O Inactive

[[f}-‘uu want more
information about a
shared printer, click here.

If your network has
zones, click on a
name to select it.
4. Click the name of the printer you want to use.

If the printer requires a password, a dialog box appears in
which you must type the password.

20 Chapter 2; Using Your Printer

printers are listed here.

@ Note: The fonts you use in your document must be available
(installed) on the Macintosh that is directly connected to the
shared StyleWriter IL. If the fonts you use are not installed,
your document may not print properly. Click Get Info for
information about fonts available on the shared printer you
selected.

5. Close the Chooser window.

You are now ready to print on the shared StyleWriter IL.

Tips for printing
Try these tips for best results with your StyleWriter II:

= Legal-size paper. When you print on paper longer than 11
inches, close the output tray. (It's designed for paper no
more than 11 inches long.)

= Transparencies. Set both adjustment levers to the paper
icon (€1). When you print several transparencies, remove each
one from the output tray before the next one comes out of
the printer. (This eliminates any chance of the ink smearing.).

= Envelopes. Set both adjustment levers to the envelope icon
(=). Before loading envelopes into the sheet feeder, crease
the top edge to make sure the flap is tightly folded..



Chapter 3

Maintaining Your Printer

The StyleWriter IT is designed for trouble-free operation.
Maintaining the printer simply means replacing the ink cartridge
when it runs out, refilling the sheet feeder, and occasional
cleaning.

For other service, see the information about service and support
that came with your StyleWriter II.

Safety first

Follow these safety tips to avoid damage to the StyleWriter II
printer and harm to yourself and other users.

= Don’t move the carriage that holds the ink cartridge. You can
damage delicate moving parts.

= Don't touch the print head on the bottom of the ink cartridge.
Ink can leak out and cause stains.

= Don't attempt to print anything when the access door is open;
this can cause paper to jam. Any time the door is open, keep
fingers away from moving parts.

= Don't oil the inside of the printer.
= Don't attempt to disassemble the printer.

= Don’t use ammonia-based or alcohol-based cleaners on or
around the printer—they may react with the plastic.

= Before you unplug the printer, make sure it is turned off. (If
the green power light is on, press the power button.) Turning
the power off ensures that the carriage has been returned
securely to its home position.



Replacing the ink cartridge

Each ink cartridge lasts for several hundred pages, depending on
the kind of printing you do. If you print a lot of graphic images,
you may need to change cartridges more often.

To replace the ink cartridge, follow these steps:
1. Open the access door at the front of the printer.
Don't attempt to move the

carriage (the mechanism
that holds the ink cartridge).

These illustrations show how
to replace the ink cartriclge.
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. Open the package containing the new ink cartridge.
. Get the ink cartridge ready by following the

instructions that came with it.

. Raise the lever to release the old cartridge and

remove it.

See the instructions inside the door of the printer.

. Insert and lock the new cartridge.

See the instructions inside the door of the printer.

. Close the access door.

You have finished replacing the ink cartridge.



Cleaning the ink cartridge

If you experience problems with print quality, cleaning the ink
cartridge may improve your results. For examples of problems you
might experience with print quality, see “Image Problems” in
Chapter 4, “Troubleshooting.”

£\ Important: Cleaning the ink cartridge consumes a small
amount of ink. If you repeat the procedure unnecessarily, you
reduce the life of the cartridge. &

To clean the ink cartridge, follow these steps:

1. When you are about to print a document, click Options
in the Print dialog box.

s:ulawnt-r 1

Copies: Pages: ® All O From: [ | To: :| -
Print Quality: OBest @Normal OODraft ..

Paper Source: @ Sheet Feeder  Manual
image:_iack s Wite ] (Grem)

Notification:| None hd

Click Options.

The Print Options dialog box appears.

2. Click to place an X in the box labeled “Clean ink
cartridge before printing.”

Stﬂemrﬂer 11 Print Dptions 10

Clean ink cartridge before printing

Click to place an X in this box,

3. Click OK.
4. Click Print.
The StyleWriter I automatically cleans the ink cartridge before

printing vour document.

4 Important: After the StyleWriter II cleans the ink cartridge
and prints your document, the cleaning option is
automatically turned off. You do not have to turn it off
before printing again. 2
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Cleaning the exterior

Before you clean the StyleWriter IT printer, turn it off and unplug
the power cord. Then wipe the exterior of the printer with a
clean, soft cloth dampened with water. Be careful not to get any
liquid in the power cord receptacle.

A Warning: Don’t use ammonia-based or alcohol-based

cleaners on or around the printer—they may react with the
plastic. a
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Cleaning the interior

Occasionally you may need to wipe off paper dust or spilled drops
of ink inside the StyleWriter IL. Before you clean the inside of the
printer, turn it off and unplug the power cord. Then gently wipe
the interior with a soft, dry cloth.

A Warning: Don't use any liquid cleaners inside the printer. A



Chapter 4

Troubleshooting Safety precautions

Follow these safety tips to avoid damage to the StyleWriter II

— . ; printer and harm to yourself and other users.
Ihis chapter provides solutions to some common problems that

you may encounter while using your StyleWriter II printer. » Don't move the carriage that holds the ink cartridge. You can

; : ; 1% At damage delicate mechanical parts.
As long as you follow the maintenance instructions in Chapter 3, :

you're not likely to have any problems with your StyleWriter II. = Don’t touch the print head on the bottom of the ink cartridge.
The most common source of trouble is faulty software installation. Ink can leak out and cause stains.

To avoid these problems, follow the instructions in Chapter 1. L , , _ _ .
= Don't attempt to print anything when the access door is open;

this can cause paper to jam. Any time the door is open, keep

A Warning: If you have a problem with your StyleWriter 11 e ;
‘ ; : your fingers away from moving parts.

printer and nothing presented in this chapter solves it, see the
information about service and support that came with the = Don't oil the inside of the printer.
printer. Do not attempt to repair the printer yourselfl A

= Don't attempt to disassemble the printer.

s Before you unplug the printer, make sure it is turned off. (If
the green power light is on, press the power button.) Turning
the power off ensures that the carriage has been returned
securely to its home position.




The Chooser doesn’t show the StyleWriter 11
printer icon

You use the Chooser desk accessory to identify the printer you
intend to use. If the StyleWriter II icon is missing from the box
that identifies different printer types, you probably need to install
the appropriate printer software. See the instructions in Chapter 1
for installing your printer software.

The Macintosh doesn’t recognize the
StyleWriter 11

If you have selected the StyleWriter I icon in the Chooser, but
nothing prints or you get a message that there is no StyleWriter II
connected, one of the following conditions may be the cause:

» The printer has been turned off. Make sure it is plugged in
and turned on.

s Aplugis loose somewhere. Make sure that all the cables are
properly connected. See the instructions in Chapter 1 for
setting up your StyleWriter I1.

» Ifyou are trying to use a shared printer connected to another
Macintosh, make sure that the computer and shared printer
are turned on and connected to the network. Also make sure
that the printer is set up to be shared. See the instructions in
“Sharing Your Printer With Other Users on a Network” in
Chapter 2.
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» The port selected in the Chooser isn't the same as the port
the printer is plugged into on the Macintosh. Try switching
from the printer icon to the modem icon (or vice versa) in the
Chooser.

= There may be a problem with the printer software. Try turning
the printer off and then on again.

If you still can’t resolve the problem, the printer may not be
functioning properly. See the information about service and
support that came with your printer.

Text changes to the Geneva font

When your Macintosh is low on memory, some fonts may be
displayed and printed in the Geneva font. Some text may also
look jagged on the edges rather than smooth.

For more information about fonts, and for suggestions on how to
free up memory, see the books that came with your Macintosh or
with your latest system software upgrade. You can also see an
authorized Apple service provider about installing more memory
in your Macintosh.

If text changes to the Geneva font when you are printing on a
shared printer, the fonts in your document may not be available
on the Macintosh connected directly to the shared printer. Use
only the fonts installed on that Macintosh. For more information,
see “Printing on a Shared Printer on a Network” in Chapter 2.



Paper is jammed

Occasionally a piece of paper may get jammed (stuck) inside the
printer during the printing process. To clear a paper jam:

1. If necessary, open the printer to see where the jam is.
2. Clear the jam.

Pull jammed sheets from the back of the printer whenever
possible.

Remove jammed paper
this way if you can.
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Paper feeds improperly

If paper tears, gets skewed, or comes through the printer
crumpled, it may not be entering the printer properly. Try the
following steps:

= Make sure you have loaded the sheet feeder correctly.
See the instructions in Chapter 2 for loading paper.
= Do not overload the sheet feeder.

The feeder holds up to 100 sheets of 20-b. paper. If you use
heavier paper, fewer sheets will fit in the feeder. Don’t insert
too much paper in one stack.

s Try to recover any torn or damaged pieces of paper
from the printer.

See “Paper Is Jammed” earlier in this chapter.
= Take the paper out of the sheet feeder and check it.

Try flipping the stack over to print on the other side (most
paper has one side that prints better).

Fan the paper to make sure sheets don't stick together.
Make sure none of the sheets are bent or dog-eared.

Make sure the edges of the stack line up evenly.
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The StyleWriter Il won't print a particular
document

If you attempt to print a document and no page is printed, try the
following steps:

» Check for messages on your Macintosh screen.
s Check the printer.
Does it have paper? (To load paper, see Chapter 2.)

Is the paper jammed? (To clear a jam, see “Paper Is Jammed"
earlier in this chapter.)

Do the lights indicate a problem? ('To check the lights, see the
next section.)

= Repeat the printing process.

Sometimes problems disappear when you try to print your
document again.



The lights indicate a problem

Sometimes the lights on the printer can signal a problem. The
following list describes these indications and tells what you should
do about them.

Both lights are off. Check to make sure the power cord is
plugged in properly and the printer is turned on. Make sure
there is power to the outlet. If the lights stay off, see the
information about service and support that came with the
printer.

The error light glows steadily. Either the printer is out of
paper or paper has been misfed. Check your Macintosh

screen for messages. See Chapter 2 for instructions on loading
the sheet feeder, or “Paper Is Jammed” and “Paper Feeds
Improperly” earlier in this chapter.

[mage problems

Most of these result from problems with the ink cartridge or with
your choice of paper. Here is a list of papers to avoid:

coated, extremely thick, or shiny paper (because the paper
may not properly absorb the ink)

erasable typing paper
damaged or wrinkled paper
stapled paper

multipart forms

For best print quality, use 16-Ib. to 24-Ib. cotton bond paper.
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Image is too light or too dark

If printing looks fuzzy because it's too light or too dark, try the
following;

»  Clean the ink cartridge. If this doesn't help, replace the
cartridge. See “Cleaning the Ink Cartridge” and “Replacing the
Ink Cartridge” in Chapter 3 for instructions.

» Ifthe problem occurs on nonstandard paper, try printing on
the recommended 16-Ib. to 24-b. cotton bond paper.

» Try flipping the stack of paper in the sheet feeder. Most paper
has one side that prints better.

= Make sure that both adjustment levers are set to the proper
icon (€1 for 16-Ib. to 24-Ib. paper and transparencies;
&= for envelope and paper heavier than 24-Ib.). See “Loading
the Sheet Feeder” in Chapter 2 for instructions.
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Ink smears when rubbed

Don't handle pages before they are completely ejected from the
printer and are delivered into the output tray. This allows all the
time needed for the ink to dry.

Printing appears on only part of the paper

Make sure you have selected the appropriate paper size in the
Page Setup dialog box.

The ink cartridge may need to be cleaned, or it may be empty. See
“Cleaning the Ink Cartridge” and “Replacing the Ink Cartridge” in
Chapter 3 for instructions



A page prints off center or images are out of place

This problem may be a result of one of the following conditions:

You may have selected the wrong page size in the Page Setup
dialog box.

The margins may be set incorrectly in the document you are
printing,

The sheet feeder is too full.

Paper is not placed properly in the sheet feeder. See “Paper
Feeds Improperly” earlier in this chapter.

You are not using the recommended paper (16-b. to 24-Ib.
cotton bond).

Nothing prints on the paper

If you get a blank page, clean the ink cartridge. See “Cleaning the
Ink Cartridge” in Chapter 3.

If that doesn't work, replace the ink cartridge. See “Replacing the
Ink Cartridge” in Chapter 3.

Unwanted lines or stripes appear

If white lines appear on the page, try the following:

Clean the ink cartridge. See “Cleaning the Ink Cartridge” in
Chapter 3.

Take the cartridge out and install it again to make sure it is
secured properly.

Replace the ink cartridge. See “Replacing the Ink Cartridge” in
Chapter 3.
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Stains appear on printed pages

If stains appear on the backs or tops of printed pages, it may
mean that there is ink inside the printer. If so, the ink can transfer
to the rollers and from there to the paper.

Turn the printer off and unplug it. Then open the printer and
carefully clean the rollers and platen with a soft, dry cloth.

Clean the rollers with
a soft, dry cloth. Clean the platen,
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Image prints wavy or distorted

Wavy or distorted images usually mean that your StyleWriter 11
requires service. Try cleaning the ink cartridge. (See “Cleaning the
Ink Cartridge” in Chapter 3.) Also check the setting of the
adjustment lever inside the printer (above the ink cartridge). If
the problem persists, see the information about service and
support that came with the printer.



Appendix

Specifications

Marking engine

» Thermal ink jet

Resolution

= 360 dots per inch (dpi) for text and graphics (180 dpi in draft
mode)

Speed

s Upto 3 pages per minute in draft mode

= Up to 2 pages per minute in normal mode

= Upto 1.5 page per minute in best mode

»  Actual speed depends on the images printed and on the
Macintosh used.

Interface
» Apple-style RS-422 asynchronous serial

Paper feed

= Automatic sheet feeder holds up to 100 sheets of 20-b. (75
g/mz) paper or 15 envelopes.

Printing materials

= Apple recommends 20-Ib. cotton bond (75 g/mzj paper. You
can use 16-Ib. (60 g/mz') to 24-b. (90 g/mz) paper.

» Accepts most letterhead and colored stock.

= Accepts medium-weight photocopier labels.

s Use #10 business envelopes: 243.5mm x 105.8mm (9.5" x
4.125").

= Apple recommends 3M brand CG3480 transparency film.

Paper sizes

a  US. letter: 215.9mm x 279.4mm (8.5" x 11")
s US. legal: 215.9mm x 355.6mm (8.5" x 14")
= Executive: 184.2mm x 266.7mm (7.25" x 10.5")

s Adletter: 210mm x 297mm (8.3" x 11.7")

= Monarch envelopes: 104.1mm x 241.3mm (4.1" x 9.5")

n  #10 envelopes: 241.3mm x 104.8mm (9.5" x 4.125")

33



Imageable area

s Maximum printable line: 203.2 mm (8.0").

= Minimum top and bottom margins: 6.25 mm (0.25").

s Minimum left and right margins: 6.35 mm( 0.25").

= Actual imageable area may vary depending on the application
program.

Dimensions

» Height (paper support down): 18 cm (7")

w  Width: 34.5 cm (13.6")

= Depth (output tray closed): 20 cm (7.9")

Weight

s 3kg(6.61b.)

Operating environment
Temperature

s 15°1030°C (59°t0 86°F)
Humidity

» 20 to 70 percent, noncondensing
Other

s Keep the printer away from wind and fans.
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Input electrical requirements

U.S./Japan

s 90-128 VAC, 48-62 Hz
Europe/UK/Australia

u  198-264 VAC, 48—52 Hz

Power consumption
Operating

w195 W maximum at 120V
s 18 W maximum at 220V
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cleaning 21, 24, 25
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location for 3, 34
logging usage of 19
lubricating 21
networks and 11, 18—20, 26
plugging in 6
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turning on 8
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printer port
Chooser problems and 26
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random-access memory (RAM), See memory
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serial ports, 33. See ports
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loading sheet feeder 7, 14—15, 20
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Setup option (Chooser) 18
shared printers. See network printing
Sharing Setup dialog box 18
Share this Printer option 17
sheet feeder
loading 7, 1415, 20
troubleshooting 28, 30
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of paper 33
smears on printed page 30



software. See application software; printer
software; system software
specifications
paper 14, 33
printer 33—34
system |
speed specifications 33
stains on printed page 31
status lights 8, 29
stripes on printed page 32
StyleWriter Il Installation disk 9—10
support 21, 25
switch, on/off 8
system requirements 1
system software
background printing and 17
displaying version 8
required version 1
upgrading 10

i 3

technical information. See specifications
television interference iii

temperature requirements 3, 34

test page 8

thick paper 14, 20. See also paper
three-hole punched paper 14, 15. See also
paper
transparencies. See also paper
loading 14
printing on 20
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TruéType fonts 1
turning off printer 21, 25
turning on printer 8
typefaces. See fonts

UV

unplugging printer 21, 25
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memory 26

system software 10
usage logs 19
user groups 10

W, X Y, Z
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of paper recommended 14, 29, 30
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white lines on page 31
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The Apple Publishing System

This Apple manual was written and edited on a desktop publishing system using Apple
Macintash computers. Proof pages were created on Apple LaserWriter printers and on
the QMS ColorScript 100 color printer. Final pages were produced in QuarkXPress and
output directly to separated film on Linotronic imagesetters. Line art was created with
Adobe Hustrator. Cover art was produced with Adobe Photoshop, Screen shots were
created and modified with system software, Exposure, and MacPaint 2.0.

Text type is Apple’s corporate font, a condensed version of Garamond. Ornaments are
ITC Zapt Dingbats™ and custom symbols designed for Apple Computer.

PostScript”, the LaserWriter page-description language, was developed by Adobe
Systems Incorporated.
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